Who we are and what we do

Central IT services are provided for you by Information Services Division.

You can:

- Find out more about what we offer online: www.ucl.ac.uk/isd
- Follow us on Twitter: @uclisd
- Find out more about us at: www.ucl.ac.uk/isd/about
- Keep up to date with news and developments: www.ucl.ac.uk/isd/news

www.ucl.ac.uk/isd
Access central IT systems

Your user ID and password is your key to UCL’s IT systems. Keep your details safe!

www.ucl.ac.uk/isd/userid-passwords

Your user ID
You will be issued with a personal user ID and password. These credentials will give you access to UCL-wide IT facilities. Your user ID is seven characters long and looks something like: ucaaxxx

Your password
We’ve set an initial password for you to get up and running. But you should now change it to something only you know. Do this using the MyAccount service: https://myaccount.ucl.ac.uk

You will need to register your mobile phone. This will allow you to reset your password without having to visit the IT Services Desk, should you forget it or if it expires.

When you set a new password, it will be valid for 100 to 350 days, depending on the strength when you set it. The stronger the password, the longer you can keep it.

Confused about how to log in?
For all systems you need your UCL password, but you may need to enter your user ID in different formats.

- **Email** (Outlook Web Access): <your user ID>@ucl.ac.uk
- **Wireless**: <your user ID>@ucl.ac.uk
- **Staff desktop** (and student computer workrooms): <your user ID> only. You do **not** need to add @ucl.ac.uk.
Top tip!
How to choose a password using MyAccount

Do:
set a strong password using 10-30 characters.

Don’t:
base your password on your personal details.

Do:
use at least three of the following different types of characters: lowercase, uppercase and numbers and symbols.

Note: there are certain symbols and characters that are not acceptable. Please see online guidance for help with choosing an acceptable password. [www.ucl.ac.uk/isd/acceptable-password](http://www.ucl.ac.uk/isd/acceptable-password)

Need an example?
One simple trick is to take 3 words and join them together with a number and a symbol (from the acceptable characters list).

Although this will be more characters to type each time, using linked words should be both easier to remember and quicker to type.

For more information, including advice on setting a strong password, see: [www.ucl.ac.uk/isd/acceptable-password](http://www.ucl.ac.uk/isd/acceptable-password)

Once you’ve got that great new password...

- Don’t keep a record of your user ID and password together.
- Never give your password out to anyone else.
- If you have reason to believe that your account has been tampered with at any time, change your password immediately and let the IT Services Desk know as soon as possible.

Note: You will receive an email reminder 30 days before your password is due to expire. You can reset it yourself through MyAccount, using your registered phone for verification. [https://myaccount.ucl.ac.uk](https://myaccount.ucl.ac.uk)
Check your email & schedule meetings

live@UCL is the email and calendar service for staff and students.

www.ucl.ac.uk/isd/email-calendar

Your email address

When you log in to your email account, your first message will be from the Postmaster informing you of your email address. It will be based on your name, e.g. f.bloggs@ucl.ac.uk

Different ways to access

At work: Use Outlook to access your UCL email and schedule meetings with colleagues.

At home: Log in via the web using Outlook Web Access (OWA).

On the move: Synchronise your mobile device with your email and calendar.

When you log in to OWA...

Remember: you must append your user ID with @ucl.ac.uk. e.g. ucaaxxx@ucl.ac.uk
Top tip! How to set a signature

According to UCL protocol, signatures should contain your work title, department, as well as phone number, email address and relevant web address where appropriate.

To set one up

- **Outlook Web Access (OWA)**
  Click on the settings button on the top-right corner and select Options. Select Settings from the left hand window pane and click on the mail tab.

- **Outlook 2013/16**
  In a new message window, in the Include group, click on the Signature button and select Signatures...

- **Outlook for Mac 2016**
  In a new message window, select the Message tab. Select Select Signatures > Edit Signatures

Example signature

Cathy Brown
Faculty Manager
Arts and Humanities; Social and Historical Sciences
Tel: 020 769 1347
Internal: 31347
Mobile: 07826892046
Email: cathy.brown@ucl.ac.uk
www.ucl.ac.uk/ah-shs-office

Any variations or additions to this format should be agreed by the relevant Head of Professional Services or Faculty Manager.
eduroam is the wireless service connecting you around campus. You can also connect remotely to the UCL network.

Wireless access on campus
eduroam is a free wireless service and available throughout campus.

Connection guides
Follow the instructions online on how to connect for your device. You will need your user ID and password.

Will you have guests visiting UCL?
Your visitors can also be provided wireless access through our UCLGuest service.

When you connect to wireless…
Remember: you must append your user ID with @ucl.ac.uk.
e.g. ucaaxxx@ucl.ac.uk

Connect from outside UCL
The UCL Remote Access VPN Service provides a resilient, secure means of accessing UCL central services from off-site locations.

Examples of services available via UCL VPN:
- MyView
- MyFinance
- Central file storage (Filestore@UCL)
- Management Systems Database Servers
- UCL MS Key Management Servers
- UCL Desktop data/applications
eduroam is a JANET Roaming Service (JRS) that enables you to use your UCL credentials (e.g. ucaaxxx@ucl.ac.uk) to access the internet from UCL or any participating institution.

The instructions for connecting are the same regardless of location. However, it is recommended you search for eduroam-participating organisations.

Top tip!
Did you know? You can connect to wireless at other institutions
Hardware purchasing
If you need new hardware, don’t run off to PC World to buy your new equipment.
On our website, we offer recommendations for corporate IT equipment. We also provide a managed desktop service (Desktop@UCL) where we will order, install and support the equipment for you.

Discounted software for home
Through UCL software agreements, you can get discounted or free software for use on personal machines.
You can obtain a copy of Office 365 at no cost. For further information and other discounted Microsoft Windows software see www.ucl.ac.uk/isd/microsoft-software
For other software see swdb.ucl.ac.uk and look under the licences for each product.

UCL licensed software
Download free anti-virus software plus any site-licensed software to which you are entitled from the software database.
Top tip!
Use Software Database to find out which applications are available on our desktop services and for personal use.

Go to: https://swdb.ucl.ac.uk

Search for a variety of software to discover what is available to you.

We have information on how to install and activate products, whether it’s free or needs payment.

Did you know we have resources from vendors on how to get more out of their products?
Brush up on your IT skills
Practical tools and resources to help you.

www.ucl.ac.uk/isd/training

Course programme
We have an extensive programme of courses, workshops and demos including:

- Creating accessible documents
- Microsoft Office
- Photoshop, Infographics
- Mac and iPad
- UNIX
- SharePoint and Teams
- Digital notebooks
- Interactive whiteboards
- Mind mapping and assistive technology
- Presentation software
- Blogging with WordPress
- Data analysis with SPSS, Stata, R, Matlab
- Document layout with LaTeX and Word
- Screen casting and video editing

Online resources
Prefer to learn at your own pace? Take a look at our selection of course materials, videos and other online learning materials to help you develop your skills. Find out more overleaf.

One-to-one help
We hold regular drop-in sessions during term time where you can get individual support with your IT needs.
Digital Skills Development

Digital Skills Development is our Moodle course containing all of the training materials and sample files used in our classroom courses as well as essential pre-learning for some sessions.

LinkedIn Learning

LinkedIn Learning offers FREE unlimited access to over 5,000 training courses for staff and students. Learn business, software, technology and creative skills to achieve personal and professional goals.

LinkedIn Learning is available through any web browser or download the app from your app store.

www.ucl.ac.uk/linkedinlearning
Your password
Look after your login details. If someone else uses them, they may cause you and others a great deal of trouble. UCL will never ask you to reveal your password. Ignore all emails asking for your passwords.

Your computer
Ensure that your machine/devices are up to date
This includes your operating system, applications, your browser, and any plugins.
Keep your anti-virus updated and your firewall enabled
You can download anti-virus software for free from UCL’s software database. The software also includes a firewall that you can use to protect your systems.

Your data
Be wary when reading your email
Be aware of phishing; do not click on any links or attachments in unsolicited email.
Back up your data regularly
Make sure your backup is not located in the same place as your working files.
Handling sensitive information
If you’re handling confidential or sensitive information, check our guide on encryption www.ucl.ac.uk/information-security/technical-advice/encryption.
For further advice, please contact us: isg@ucl.ac.uk.

Your responsibilities
As a member of staff you are bound by the UCL Information Security Policy. www.ucl.ac.uk/information-security/information-security-policy
Top tip!
Learn the basics
Can you tell the difference between legitimate emails and phishing scams?
Do you know your malware from your ransomware?

Take our security course
Our Information Security Awareness course on Moodle has information on email scams, protecting data, passwords and policies.
Log into Moodle, search for “Information Security Awareness”, and self-enrol.
https://moodle.ucl.ac.uk/

Manage your passwords
LastPass is a password manager that allows you to store all your passwords encrypted in one place. The advantage of using a password manager is that you only ever have to remember one password, instead of dozens for all the individual accounts that you have. It also discourages you from re-using passwords, which is not good practice.

www.ucl.ac.uk/isd/services/stay-secure/lastpass

Stay secure
Get general information and help on staying secure online.
UCL will never ask you for your password. Please ignore such requests and report them to the IT Services Desk.
www.ucl.ac.uk/isd/stay-secure

Keep up-to-date with the latest on information security via our blog:
https://blogs.ucl.ac.uk/infosec/
Use technology to enhance the student experience

www.ucl.ac.uk/isd/learning-teaching

Digital resources, activities, communications and assessment are now an integral and valued part of the UCL student experience. Students expect a well-designed online environment to supplement and enhance their studies.

- **Moodle** is the central hub for online learning at UCL. All taught modules have associated courses in Moodle, and these must now align with the UCL E-Learning Baseline setting out minimal requirements in areas such as layout, information and accessibility.

- **Online assessments** such as Turnitin assignments and tools within Moodle can be used to support assessment and feedback and are appreciated by students. MyFeedback allows students and tutors to view their feedback and grades in one place on Moodle.

- **Lecturecast** is an automated UCL system to record lectures and deliver them through Moodle. Students now use this extensively to follow up on lectures and as a revision aid.

- **UCL eXtend** is our public-facing online course platform available for learners outside UCL and increasingly used for continual professional development and executive education.

UCL Digital Education is here to help you design your modules and use technology effectively to enhance the learning and digital experience of your students. We support individuals, departments and communities such as our E-learning Champions to develop ideas and new approaches.
Top tips!

- Use Moodle quizzes or H5P to create interactive online quizzes to help students check their progress.

- Reflect is our blogging tool on a WordPress platform. Students can work independently, or collaboratively with their peers to create blogs, websites or portfolios that they can share with others.

- Use voting software or interactive slides in Lecturecast to encourage better student engagement.

- The Turnitin service via Moodle, enables you to provide online feedback via Moodle and helps check for plagiarism.

- Communicate with your students using Moodle Forums to encourage group discussion and provide feedback.

- Use ReadingLists@UCL to give your students direct, click-through access to online resources and to Library Catalogue records for items that are available offline.
Your desktop

Access your desktop at work or from home.

www.ucl.ac.uk/isd/computers

Staff computers

Our desktop service gives you access to your files, applications and desktop from anywhere in the world as long as you have an internet connection.

Where to save your work

Keep your files safe on the central filestore (Filestore@UCL) which is backed up every night. You can also use a shared data area (S: drive) which can be accessed by colleagues in your department and is useful for collaborating.

Computers in lecture theatres or student computer workrooms

We provide IT and AV equipment in centrally bookable lecture theatres and computer workrooms across campus. How-to guides and support information for lecture theatres and student computer workrooms are available online.

When you log on:

You only need to enter your user ID. Do not append with @ucl.ac.uk

Remote access

Working from home or on the move? We provide services that allow you to remotely access your desktop, files, and UCL software applications and systems (see overleaf).
Top tip!
...use Desktop@UCL Anywhere for remote access to your files and folders.

Remote access using Desktop@UCL Anywhere

Desktop@UCL Anywhere gives you access to UCL services remotely. There are two ways to access Desktop@UCL Anywhere, you can either:

• Install the Citrix receiver, which is a piece of software installed on your computer that allows you to connect to Desktop@UCL.

• Alternatively you can connect directly to Desktop@UCL from your web browser.

How-to guides and further help can be found on our web pages.

www.ucl.ac.uk/isd/services/computers/remote-access/desktop
Print anywhere on campus

Centrally managed print services.

www.ucl.ac.uk/isd/print-copy-scan

Print, copy, scan

This is called the Print@UCL service.

Send your print job from our desktop service or your own computer or laptop. Then use any device around campus to print your document. You can also use any device to copy and scan quickly and easily.

You can even email your print job from your mobile device and collect from any print device connected to the service.

Print@UCL in your department?

Check whether your department is using the Print@UCL service (at present not all departments are). If not, contact your local IT support team to find out the printing arrangements for your department.

The first time you use Print@UCL...

Register your UCL ID card

The first time you swipe your ID card at the printer, you will need to register on the system. To register, enter your UCL user ID and password using the printer’s key pad. Your user ID does not need to be appended with @ucl.ac.uk.

Any time after that:

All you need to do is swipe your UCL ID card to log in.
Top tip!
How to print in colour

Go to Print (Ctrl + P or File > Print)

Choose Options or Properties and select Image Options.

On the Color Correction tab, deselect the Xerox Black and White Conversion checkbox.

Select OK and Print.
We develop, deliver and operate services to assist UCL researchers in meeting their objectives at each stage of the research lifecycle, from funding through to publication and dissemination.

Your UCL profile
IRIS (Institutional Research Information Service) is the internal and public research portal for UCL. Use IRIS to maintain your own researcher profile and to identify the research activities of others.

Your publications list
The Research Publications System (RPS) is designed to provide UCL researchers with a single point of entry for keeping their publications up to date. It integrates with both IRIS and Discovery, UCL’s open access full-text repository.

Assistance with other Research IT services
Find out how else we can help you. Our range of services include: Research Computing, Research Software Development and Research Data Services.

Training
We run various courses ranging from an Introduction to High Performance & High Throughput Computing, to Software Carpentry Workshops.
We can provide support for coordinated end-to-end research ‘workflows’ encompassing the use of both data storage and computational resources. We can help you plan in advance how you are going to manage, store and preserve data beyond the lifetime of your research project and allow its re-use and citation by the wider academic community.

Using the Research Data Services’ Storage and Repository services will help you comply with both UCL’s policy and UK funding bodies’ requirements to manage data effectively throughout the research lifecycle and make datasets accessible to the widest possible audience.

Email: rits@ucl.ac.uk

Top tip!
Talk to us about the service

Talk to us about how the Research Data Service can provide safe, resilient storage for your research project data.
Digital Accessibility

Do you have a disability and need advice on assistive technology?

www.ucl.ac.uk/isd/disability-it

Assistive technology
Do you have a disability and need advice on assistive technology? Contact the Digital Accessibility Technologists who can advise you on software and hardware to meet your needs.

Ergonomics
Do you have questions about workstation health or ergonomics? Learn about the simple adjustments that can make your workstation more comfortable.

Digital Accessibility Technologists
We’re here to help you. Whether you have a temporary challenge which is affecting your work or a long term issue, our Digital Accessibility Technologists can provide support.

Digital Accessibility Hub
For students with disabilities, we have a dedicated computer workroom equipped with an up-to-date range of software and technology.

For access and to book inductions please contact the Disability Service on either disability@ucl.ac.uk or contact 0207 679 0100.

Contact details
Email: atteam@ucl.ac.uk
Tel: 020 7679 2809 (int. 32809) / 020 3018 4419 (int. 54419)
Location: Digital Accessibility Hub, Wilkins Building, B10
Top tip!
Are you sitting comfortably?

Bad habits and incorrect posture can lead to aches and pains. Maintain good posture at your workstation by following these tips.

- Viewing distance between 16–24 inches
- Top of monitor at or slightly below seated eye level
- Home row of keys should be at or slightly above elbow height
- Mouse should be next to the keyboard at the same height
- Shoulders relaxed
- Keep wrists straight and fingers relaxed
- Arms relaxed at sides with upper and lower arms forming a 90-degree angle
- Lower back supported
- Thighs parallel to the floor forming a 90-degree angle with the lower leg
- Feet flat on the floor
- Home row of keys should be at or slightly above elbow height
- Mouse should be next to the keyboard at the same height
Dial to talk

Telephony Services has comprehensive solutions for your mobile telephony needs, conference calls and your desk phone.

www.ucl.ac.uk/isd/telephony

Telephony service
If you need anything, from a headset or desk phone, to a call centre or just some simple advice, email us on is-telecoms@ucl.ac.uk

Mobile phones
Use our online service to choose from a range of handsets and contracts and manage your mobile phone.
www.ucl.ac.uk/mobiles

Conference and collaboration
We have conferencing solutions to provide a simple voice conference from your desk, a national or international option and options to share your desktop or provide full video conferencing. See online for further details.

Out of office voicemail messages
UCL’s voicemail facility is not provided by default. You will need to request this for your extension number. There is no charge for voicemail accounts.

Dialling colleagues
Many UCL buildings are connected together and we use extension numbers of 5 digits. When calling other colleagues from your desk phone, please dial the internal extension number, rather than using the full telephone number.

Anything starting with a 9 is an external call.
Top tip!
How to find UCL contact numbers

You can find other contact numbers by using the UCL directory or the Global Address Book via your email program.

Find people using the UCL Directory

Go to: www.ucl.ac.uk/directory
Enter the name of the person you are looking for.

Find people in your email program

Outlook Web Access (OWA):
Click on the People button (top right) > select Directory (left side).

Outlook 2013/16:
On the Home tab, in the Find group, click on Address Book.

Outlook 2016 (Mac):
On the Home tab, click on Address Book.

Important numbers

UCL emergency number: 222
UCL switchboard: 100
Maintenance Emergency/Security Control: 33333
IT Services Desk: 25000
Estates Helpdesk: 30000
Tools to help you with your admin functions

From finance to conference bookings.

www.ucl.ac.uk/services

Administrative Applications

Systems to help

You will likely need access to some of the administrative systems we run to help you do your job. Examples of some of the systems available to you are:

- MyFinance – purchasing and goods receipting, expense claims and season ticket loans, financial reporting and management
- HR Processes – payslips and staff self-service functions, annual leave and sickness notifications, internal training and more
- Archiving and records management
- Alumni and fundraising information
- Recording visitors
- Booking rooms
- Portico – the student information system
- Creating an academic timetable

Access to admin services

You will need to register for some of these services. Help guides and information are available online.

Most administrative applications require your UCL user ID and password.
Top tip!
Use the services@UCL website to find admin services

Go to: www.ucl.ac.uk/services
You can list by:
- System
- Process or
- Unit

Once you start using services@UCL, the application will begin to remember the systems you have visited in the past; to enable you quick access back to those systems.
Get creative!
For all your creative and media requirements.

www.ucl.ac.uk/isd/digital-media

Design and photography
Comprehensive design and photographic service which supports UCL-wide learning and teaching, promotional and PR activities.

Poster production
Printing service – for academic posters and exhibition quality large format prints.

Media production and media delivery
A broadcast quality service, offering location and studio production, in-house facilities, live streaming of events and media delivery through UCL Mediacentral, Apple Podcasts, SoundCloud, Facebook ‘Live’ and Twitter ‘Periscope’.

Digitisation and scanning service
State-of-the-art digitisation service by expert technicians and incorporating film, document and book scanning equipment which provide high quality digital imagery for research and archival purposes.

Imagestore and Mediacentral online image and audio/video portal
Contains images and videos of UCL activities, events, places and people. For use online, in print, websites, presentations, teaching materials and research activities.

www.imagestore.ucl.ac.uk
www.ucl.ac.uk/mediacentral
Top tip!

For Design...

For Posters...

For Photography...

For Video...

**Design:** Be open minded, especially to new design concepts and ideas and always check that you are complying with the UCL Visual Identity guidelines. [www.ucl.ac.uk/visual-identity](http://www.ucl.ac.uk/visual-identity)

**Posters:** For academic posters, always provide both PowerPoint (.ppt) and PDF (.pdf) files where possible. However, remember that what you see on screen is not necessarily what you will see in print so allow time for amendments – which we are happy to help with.

**Photography:** We suggest, wherever possible, that you try to use professionally produced high resolution imagery. We are here to help and can undertake photography for you, or if your prefer give advice on producing your own images. Image (right), shows the UCL Pearson Studio.

**Media equipment loan:** For UCL staff we offer a variety of media equipment for short-term loan. Contact digitalmedia@ucl.ac.uk for further information.

**Video:** The video production process can be time consuming, so contact us in plenty of time before you need your production, that way we can help you better plan and prepare. We also offer an equipment loan service.
Help with your website

Let us help you create a great website.

www.ucl.ac.uk/isd/websites

Websites

Will you be maintaining a website as part of your role?

We provide advice and assistance on all aspects of websites, from content management and user experience, through design and development, to training and ongoing support.

And remember, your website is very important so make sure you spend time managing it!

So let us help you make your website as successful as possible.

For more details see: www.ucl.ac.uk/isd/websites
Top tip!
Lots to consider...

There's a lot to consider when you decide to design or redesign a website including:

• What are the purposes of the website?

• Who are the users and what are their top tasks on the website?

• How do you create accessible content for all your audiences?

• How can you make sure that the website has a high ranking in Google?

• Who will keep the website up to date?

• Find out more: www.ucl.ac.uk/building-great-websites
Have you joined one of the following departments or schools?

- The School of Life and Medical Sciences (SLMS)
- The Bartlett
- Institute of Education (IOE)
- The School of Laws, Faculty of Arts and Humanities, Faculty of Social and Historical Sciences and SSEES (SLASH)

If so, we can help you with your IT. Being in one of the above departments gives you access to a broad range of specialty IT services in addition to the central IT offerings.

IT for SLMS

In addition to your usual IT provision, IT for SLMS can provide or facilitate a range of services across SLMS:

- **Research** – guidance and advice on all aspects of ISD’s range of research IT services
- **Information Governance (IG)** – advice, support and training on legal and regulatory compliance when using sensitive research data
- **Health Creatives** – providing clinical and general photography, design, web & app development, print and video services
- **Learning and Teaching** – including e-learning facilitation and audio visual support

www.ucl.ac.uk/isd/itforslms
The Bartlett

The team in the Bartlett supports activity across the Faculty and Institutes both in Bloomsbury and at Here East.

In addition to the standard IT services (student computer workrooms, desktop and laptop support), the team in the Bartlett offer support for specialist and large format printing and 3D rendering.

There is also support for the many specialist software packages used both for teaching and research.

SLASH

The team operates predominantly across the Bloomsbury campus. The primary administrator in your department can introduce you to the local IT Support Technician(s) assigned to support the department/faculty.

In addition to your usual IT provision, IT for SLASH can provide or facilitate a range of services including:

- **Learning and teaching** – including e-learning facilitation and audio visual support.
- **Digital service walkthrough** – including advice on best practice in data storage and use of digital tools available.
- **Digital development** – using collaborative Microsoft tools, the local IT for SLASH team can support the development of customer experiences to support collaboration with colleagues within and partners external to UCL.
- **Research** – research facilitation and guidance on research IT services including support in the procurement of Information Technology investments through research grants.

IOE

IT for IOE provide a wide range of additional IT services which include:

- **Media Services** – providing a wide range of services from filming & streaming of events and lectures, editing & distribution of digital media to video conferencing facilities
- **Learning and Teaching** – including e-learning facilitation and audio-visual support
- **Research IT and Information Governance** – workshops and one-to-one support for popular applications used in social science / education research at the IOE, including R Studio, STATA, SPSS, Nvivo

Advice and guidance are provided in respect of information governance and information security questions in relation to the conducting of research at the IOE.
Need to report a problem?
The IT Services desk is your first point of contact for all requests and queries.
Self-service portal: www.ucl.ac.uk/isd help
Tel: 020 7679 5000 (internal: 25000)
Visit: Main Library, Gower Street; DMS Watson Library, Malet Place; IOE Library, Bedford Way
Email: ITServices@ucl.ac.uk

Hours of support:
Telephone Support:
8:30am – 5:30pm
Monday – Friday
Out of Hours Telephone Support:
5:30pm – 8:30am
Monday – Friday, including overnight, weekends, all UK Bank Holidays and UCL closure days. (Note: vacation times vary)
IT Services Desk Open Hours:
Monday to Friday from 9:30am – 6pm
Saturday at the IOE Library from 11am – 1pm and 2pm – 4pm

Other ways to find information
Online: www.ucl.ac.uk/isd/help
Follow us on Twitter: @uclisd
Service news: www.ucl.ac.uk/isd/news
Top tip!
Use the self-service portal

The self-service portal is your single point for submitting a problem/request and you can track any outstanding tickets you may have open.

To do this, click on the **Access the self-service portal** button on the Help & Support web page: www.ucl.ac.uk/isd/help

When submitting a problem or request, remember to provide your contact information!